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Introduction

Lorsque l'on évoque les possibiltés de l'infographie 3D non professionnelle sous Linux, il vient
naturellement à l'esprit les noms de Blenderet de Moonlight. En cela, les utilisateurs de Linux diffèrent
peu de ceux de Windows ou de Mac, qui justifent leur dépendance aux systèmes utilisés en avançant
toujours les noms des 2 ou 3 mêmes produits « incontournables », très chers en ressources
pécuniaires autant que matérielles. Il y a là quelque chose de contradictoire. Un créateur 3D, évoluant
constamment dans un univers imaginaire, devrait faire preuve, pour le moins, de cette imagination qui
se nourrit d'une curiosité toujours en éveil. Or, on s'aperçoit qu'il n'en est rien. Les réflexes précités
montrent au contraire à quel degré d'accoutumance leurs auteurs sont arrivés. Et il n'est pas
d'accoutumance sans effets secondaires néfastes. Ici, il s'agit du tarissement de la soif d'apprendre qui,
par nature, cherche à s'étancher à toutes les sources possibles.

Des sources, nous allons en présenter deux, qui s'entendent comme larrons en foire: un modeleur,
Ayam, et un moteur de rendu, BMRT. En espérant que la mise en oeuvre des procédures qui suivent
permettra à tous et à chacun d'arriver au résultat ci−dessous, pour commencer. La scène est modeste,
certes, mais il ne faut pas négliger les petits commencements... C'est un parti pris que de s'adresser ici
aux débutants en imagerie 3D, afin que les acquis à l'issue de ce travail puissent être appliqués à
d'autres programmes. Il s'agit d'une démarche pédagogique.
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Où trouver les programmes?

Ayam est un modeleur écrit en C, mais reposant sur TCL/TK pour l'interface. On pourrait préférer à ce
choix celui d'outils plus modernes comme QT de Troll Tech, ou GTK. Sans doute l'auteur, Randolf
Schlutz <rschultz@informatik.uni−rostock.de>, a−t'il davantage misé sur le caractère mult iplate−forme
de TCL/TK que sur l'aspect ou la réactivité de l'interface elle−même. En effet, Ayam est disponible sur
Unix (Testé sur Linux et Irix) et sur Windows. Hormis Motif/OpenMotif/Lesstif, peu de ressources sont
aussi universelles que TCL/TK.

Programme sous licence GPL, Ayam offre sur le site qui lui est dédié, <http://www.ayam3d.org>, une
archive .tgz des sources (1.8 Mo), une archive .zip avec exécutable .exe et fichiers annexes pour
Windows (3 Mo) ainsi qu'une archive .tgz avec binaires pré−compilés pour Debian (3.4 Mo). Sous
Linux, on pourrait être tenté de télécharger les sources et de se lancer dans la compilation du
programme pour une adéquation de celui−ci avec son propre système. Personnellement, j'y ai renoncé
depuis la version précédente dont la compilation s'était avèrée trop chevelue. Il est vrai que l'opération
commence obligatoirement par la modification du Makefile afin que celui−ci soit adapté à son système,
ce qui ne va pas sans difficultés. De plus, les paquetages devels de plusieurs bibliothèques,
notamment tcl, TK et Mesa, devront être installées; de même, BMRT devra être installé avant la
compilation entreprise, celle−ci recourant à des fichiers d'en−tête de BMRT.... Passons: le binaire pour
Debian (avec archive en tgz et non en .deb) fonctionne sans problème sur une Mandrake 8.2 , et je n'ai
pas rencontré de difficultés si ce n'est un défaut de rafraîchissement des fenêtres lors de leur
redimensionnement, d'origine non identifiée. On peut donc le négliger.

Ayam propose toutes les fonctions de modélisation à base de primitives et de CSG, de NURBS,
courbes et surfaces obtenues par révolution (revolve), extrusion (extrude) , balayage (sweep), lissage
(skin)... La liste est longue, et la consultation de la documention anglaise s'avère indispensable. A ce
propos, Michel Armand <michel@linuxgraphic.org>, fournit un travail acharné pour traduire en français
ce gros pavé qui sera mis en ligne sur <http://www.linuxgrapic.org>

Mais Ayam ne fournit pas de moteur de rendu interne pour calculer les scènes. Il fait appel pour cela à
un programme externe, BMRT (Blue Moon Rendering Tool) qui désigne en fait une collection d'outils
en ligne de commande, écrit par Larry Gritz, employé chez Pixar dont tout le monde connaît le très
réputé RenderMan, responsable des effets spéciaux de nombreux films. Rien d'étonnant à ce que
BMRT ressemble alors au produit de Pixar et qu'il utilise les fichiers .RIB et les mêmes shaders, au
point que l'industrie cinématographique ait fait appel à lui pour des fims tels que Little Stuart , Hollow
Man ou Swordfish. On trouvera BMRTen version 2.6 (recommandée) sur <http://www.exluna.com/> ...

Hé bien non: depuis l'association Exluna et n'Vidia, BMRT ne semble plus pouvoir être librement
téléchargé, à l'heure d'écriture de ce didacticiel (Août 2002). BMRT 2.6 est donc, pour ceux l'ont en leur
possession, à conserver précieusement jusqu'à l'arrivée de la prochaine version de Ayam, qui
s'appuiera alors très certainement surAqsis. Tout comme BMRT, Aqsis est un moteur de rendu
compatible RenderMan et cette compatibilité est assurée au niveau des shaders, dont il sera question
plus loin: sans aucune difficulté, les shaders sources .sl se compilent aussi bien sous BMRT, Aqsis,
3Delight, RenderDot que Air (commercial, lui, mais rapide)
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On peut d'ores et déjà s'intéresser à Aqsis, qui présente l'avantage d'être sous licence GPL, et d'être
disponible pour BeOS, MacOS X, Windows et Posix, donc Linux, pour lequel on téléchargera les
sources à compiler ou bien les binaires Debian. Se rendre sur:

<http://www.aqsis.com/> et <http://sourceforge.net/projects/aqsis>.

En fait, d'ores et déjà, le choix du moteur de rendu est prévu dans Ayam, même si l'accent est mis sur
BMRT. Il suffit d'ouvrir le menu >Edit >Préférences >RIB−Export >Render et d'indiquer dans ce dernier
champ le nom de l'éxécutable à lancer, en ajoutant les paramètres nécessaires. Par défaut, ce champ
contient: rendrib −d 4 −Progress %s, qui appelle l'outil de rendu de BMRT.

5

http://www.aqsis.com/
http://sourceforge.net/projects/aqsis


6



Titre: AYAM et BMRT font la paire Article disponible en:

Auteur: André Pascual

Logiciel: AYAM3D

Au commencement

Après une installation correcte, ce qui ne se fait pas sans lecture des documentaions diverses relatives
à Ayam et BMRT, le lancement de Ayam affiche un écran d'accueil, une boîte d'outils (voir Fig1:
Départ) et une fenêtre contenant des informations diverses, Main.

En cliquant sur l'écran d'accueil, celui−ce refermera, vous laissant dans l'expectative. Il faut donc
aménager l'espace de travail en créant les vues que l'on juge utiles, puis configurer l'ensemble Edit>
Préférences et enfin sauvegarder. Encore une fois, la lecture de la documentation sera un gain de
temps précieux.

Toutes les commandes de modélisation et de manipulation du contenu des vues passent par les icônes
de la boîte d'outils, par les menus de la fenêtre Main (très peu par les menus des autres fenêtres) ou
par des raccourcis−clavier qui améliorent considérablement le confort d'utilisation. Attention à ne pas
oublier que les raccourcis en question sont fonction du contexte, c'est à dire de la fenêtre active. Le
raccourci « e », par exemple (édition de points) ne fonctionne pas si la fenêtre active estMain, ou si
aucune courbe contenant des points n'est sélectionnée. Cela va sans dire, mais cela va mieux en le
disant...
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Le premier objet: le corps de l'aiguière

D'ordinaire, lorsque l'on teste un logiciel 3D, on modélise une théière. Pour mettre en oeuvre
l'imagination dont il a été question au début, on optera pour une aiguière plus ou moins pharaonique
dans sa forme. La raison en est simple: cet objet présente exactement les mêmes difficultés que la
classique théière, puisqu'il est composé d'un corps de révolution, d'un bec verseur et d'une poignée.

Commençons par le corps. Un objet de révolution, lorsqu'il n'est pas réalisé à partir d'une primitive
déformée, est constitué d'un profil,c'est à dire du contour de sa demi−section qui pivotera de 360°
autour de son axe de révolution. C'est le principe fondamental de la génération de ce type de surface
ou de volume. Mais qu'est−ce qu'un profil dans le cas présent? Imaginez un verre que l'on coupe dans
son plan médian longitudinal; on dispose donc, à la suite de cette coupe, d'un demi−verre, dont la
matière se trouve répartie symétriquement par rapport à son axe, en l'occurrence son axe de révolution
(tout objet que l'on peut obtenir en faisant tourner la matière première comme sur un tour de potier est
un objet de révolution). Imaginez que l'axe est vertical et que la partie coupée soit face à vous. Ne
considerez plus que la matière du verre qui se trouve à droite de l'axe vertical (ou à gauche): la partie
plane coupée du verre est la demi−section de celui−ci et la ligne qui peut la contenir (le contour donc)
est le profilqui nous intéresse. On comprend bien que si ce profil tourne de 360° autour de l'axe
vertical, il va balayer une espace susceptible de contenir la totalité du verre.

Pour créer notre aiguière, il convient donc de dessiner son demi−profil et de le faire pivoter. La forme et
la précision de l'objet résultant dépendra de la forme et du profildessinés. Dans le cas de Ayam, il doit
être dessiné dans une vue de face (Front, Ctrl−f)

On utilisera pour cela une courbeICurve. Le fait de cliquer sur l'icôneICurve de la boîte d'outils dépose
un segment de droite contenant 4 points de contrôle, dont le premier est placé à l'origine du répere
spatial. C'est un principe assez déroutant au départ. La plupart des programmes 3D agissent comme
les programmes de dessin vectoriel: lorsque l'on veut créer une courbe, il suffit de déposer des points
dans l'espace de travail, et la courbe se construit automatiquement en reliant les points déposés. Pas
Ayam, tout comme Cinema4D d'ailleurs: il propose un courbe particulière (rectiligne), déterminée en
position et en dimension. Il va donc falloir la déformer et lui adjoindre autant de points de contrôle
supplémentaires qu'il sera nécessaire. Actuellement, nous nous trouvons à l'étape 1, de la Fig2: Créer
un Objet de Révolution.
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Sur cette figure, est également représentée une partie de la boîte d'outils, avec les icônes qui vont être
nécessaires à la réalisation de cette étape, colorées en cyan (pour les besoins de la demonstration).

A l'étape 2, il est demandé d'insérer des points de contrôle. Pour ce faire, cliquez sur l'icône insert
point, ou tapez « i » au clavier, la fenêtre frontale étant active. Le bandeau de la fenêtre indique View
1− Front− Insert Points, ce qui est fort utile. En effet, si vous n'obtenez pas ce que vous désirez,
considerez les informations contenues dans le bandeau: la commande passée n'a peut−être pas été
prise en compte. Si la commande est active, cliquez sur un point existant: aussitôt, un point est ajouté
entre le point désigné et le suivant. Une douzaine de points pour commencer devrait suffire.

A l'étape 3, il est demandé de déformer la courbe en déplaçant les point un à un jusqu'à obtenir
approximativement pour l'instant la forme voulue. Pour ce faire, cliquez sur l'icône edit point, ou taper
« e » au clavier. Dès lors, vous pouvez cliquer sur un point existant et, tout en gardant le bouton
gauche de la souris enfoncé, vous le déplacez à l'endroit voulu en prenant garde de ne pas le déposer
au−delà de l'axe de révolution vert.

A l'étape 4, il est montré que le recours à insert point (i) et à edit point (e) est nécessaire pour affiner la
forme du profil. On remarquera que celui−ci est incomplet. En effet, dans la partie qui constituera
l'intérieur de l'objet de révolution, il ne rejoint pas l'axe. Ce n'est pas une nécessité: chacun fera comme
il voudra, mais si l'objet n'est pas destiné à être transparent, peu importe que l'intérieur, que l'on ne
verra pas, soit incomplet ou non.

A l'étape 5, il est demandé de créer la surface, chose aisée s'il en est. Il suffit de cliquer sur l'icône
create Revolve pour que la surface soit générée. A ce stade, il ne faut pas s'étonner des formes
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anguleuses affichées. Cela ne concerne que l'affichage volontairement approximatif pour des raisons
de rapidité de rafraîchissement lors des redimensionnements des fenêtres ou d'objets. Il ne s'agit pas
de la forme réelle, mais d'une armature le contenant.
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Verifier le résulat pour le modifier (ou non)

Il est légitime de vérifier la forme réellement obtenue, qui ne sera présentée correctement qu'en mode
ombré, rendu rapide ou final. La meilleure vue pour ce contrôle étant la vue en perspective, activez
celle−ci. Le contenu peut être amélioré à son goût en zoomant (bouton milieu de la souris +
déplacement) ou en panoramiquant (bouton droit + déplacement). A noter que ces fonctions sont
disponibles grâce à des icônes dédiées de la boîte d'outils. Cela étant fait, cliquer sur
>Configure>Shadeou activer Ctrl−Shift−s (Ctrl−S) pour obtenir une visualisation en ombrage (shading)
. Voir Fig3: Vérifier le résultat.

La commande Shade se comporte comme une bascule. En effet, en l'activant de nouveau, le mode
ombré est remplacé par le mode filaire.

On aurait pu effectuer cette vérification essentielle en demandant un pré−rendu, appelé ici Quick
Render, ou en effectuant un rendu final appelé Render. On accède à ces commandes soit par le menu
View de la fenêtre active, soit par les raccourcis−clavier Ctrl−r pour le pré−rendu et Ctrl−R pour le
rendu (Ctrl−shift−r= Ctrl−R).

En supposant le résultat insatisfaisant, on envisage une modification de l'objet. Il n' y a aucune crainte
à avoir, l'opération étant sans douleur. Pour ce faire, passez en vue de face parCtrl−f, et en mode filaire
par Ctrl−S ou Ctrl−Shift−s. Jusqu'à présent, seul le contenu des fenêtres graphiques ont été
considérés. Cependant la fenêtre principale, Main, a également été modifiée depuis le debut de la
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modélisation. Cette fenêtre est divisée en trois parties: à gauche, ce que l'on peut rapprocher d'un
arbre de construction classique, appelé Hierarchy dans Moonlight, et ici Objetcs ; à droite, des
informations diverses regroupées sous le nom de Properties et concernant l'objet sélectionné dans
l'arbre; et enfin en bas, une ligne de dialogue, dans laquelle on peut entrer des commandes ou lire les
messages émis par le programme.

Au départ, l'arbre contient un seul objet:Root, avec un petit + devant son nom. Si l'on clique sur le +,
Root se déploie et indique qu'il est composé de View1, View2... qui sont indiquées en couleurs grise.
Cela signifie que ces objets ne sont pas sélectionnés, ce que l'on fait en cliquant dessus. La couleur de
l'objet selectionné change, de même que le contenu de la fenêtre Properties. Il faut également
sélectionner une propriété d'un clic de souris si l'on veut en modifier les paramètres. Ajoutons encore
que le sélection multiple dans l'arbre s'obtient en combinant l'emploi de la souris et des touches
ShiftetCtrl. Classique.

La Fig4: Retouches possibles, regroupe ce qui vient d'être dit à propos de l'objet modélisé.

Dans la vue de face, il apparaît en filaire; il s'appelle Revolve dans l'arbre de construction et le
déploiement de Revolve révèle qu'il a été généré avec une courbe ICurve; celle−ci est sélectionnée, ce
qui se traduit par sa coloration blanche dans la vue de face, avec mise en évidence des points de
contrôle. On peut donc dès maintenant, dans cette fenêtre, modifier la forme de la courbe par edit
point(e). Si l'on dispose d'une petite fenêtre Perspective en mode ombré, on s'apercevra que toute
modification de la courbe par déplacement de points est inter−activement répercutée sur la surface
ombrée affichée. Le contrôle visuel n'en est que meilleur. Il s'agit là d'un point fort de Ayam.

Jusqu'à présent, il n'a pas été dit de sauvegarder le travail, car il s'agit d'une précaution qui va de soi.
Au cas où cela n'aurait pas encore été fait, sauvegardez le travail qui devrait maintenant convenir.
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Adjoindre un bec verseur ...

Une aiguière étant destinée à verser un liquide dans un récipient, il lui faut un bec verseur. La
réalisation de celui−ci fait appel à une technique jointe à une fonction particulière. La technique est
celle de la construction des coques de bateau, ou des avions en toile d'autrefois: on dispose
spatialement des profils (couples membrures pour les bateaux) sur lesquels va être déposée, tendue et
fixée la surface externe de l'objet en construction. On parle parfois de tendre une peau sur des
supports, et peut−être pour cette raison la fonction utilisée en 3D s'appelleSkin, parfois Lissage(dans
SolidWorks). On va devoir imaginer la forme du bec verseur que l'on découpe virtuellement en
différents endroits. Les sections résultantes sont les couples membrures à dessiner et à mettre en
place. Des cercles déformés, ou non, par modification d'échelle 2D feront l'affaire. La Fig6: Sections du
Bec, montre la réalisation de ce travail, dans trois vues différentes regroupées en une seule dans
l'illustration présente.

Dans le cas présenté, cinq sections sont utilisées. Il en découle que l'arbre de construction de la
fenêtre Main contient cinq objets NCurve positionnés dans l'ordre de leur création. Très important: si
l'on déplace dans la fenêtre de visualisation la 3° section, par exemple, et qu'on la positionne à
l'endroit qui devrait être l'extrémité du bec verseur, l'ordre de création n'est pas modifié pour autant
dans l'arbre de construction. Lors de la création de la surface Skin, celle−ci suivra l'ordre de l'arbre et
non celui de la position dans la fenêtre de visualisation. De la sorte, il en résulterait une surface
parfaitement incohérente.

Comment réaliser la surface Skin? En sélectionnant dans l'arbre toutes les NCurves correspondantes
aux sections du bec verseur et en cliquant sur l'icône Skin de la boîte d'outils. C'est tout. Voir Fig7:
Peau extérieure du Bec.
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Comme pour le corps de l'aiguière, il est loisible, et même recommandé, de modifier la forme du bec si
nécessaire en sélectionnant dans l'arbre de construction la section voulue et en changeant soit sa
position, soit son orientation soit sa dimension, soit sa forme... La surface extérieure sera
automiquement mise à jour.
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... et une poignée

Plusieurs façons d'opérer sont possibles dans le cas présent. En premier lieu, ce qui vient à l'esprit,
c'est d'utiliser la fonction de balayage, Sweep, qui consiste tout simplement à déplacer une section le
long d'une trajectoire. L'avantage de la méthode, est sa rapidité de mise en oeuvre. L'inconvenient est
d'obtenir un profilé de section constante, ce qui convient parfaitement à des tubes, des ferronneries
élaborées à partir de barres rondes ou prismatiques etc, donc à la poignée dont nous avons besoin.
Mais dans un but uniquement pédagogique, nous allons opter de nouveau pour la fonction Skin, afin de
la mieux maîtriser, en montrant certains aspects passés sous silence dans la réalisation du bec
verseur. De plus, nous allons la modéliser dans une session séparée, puis la sauvegarder et enfin
l'insérer dans le travail qui nous occupe. Cela nous apprendra à introduire des objets existants,
provenant de bases diverses, dans une scène en cours.

Fermer la scène, puis commencez−en une nouvelle par >File>New.

De la même manière que pour la réalisation du bec verseur, il suffit de disposer des cercles le long de
l'axe médian (qu'il faut imaginer, hé oui!) de la poignée: six en tout. Si le profil de cette poignée est
constant, les six cercles seront identiques est pourront être placés par recopie >Edit> Copyet >Edit>
Paste. Noter que les raccourcis clasiques Ctrl−c (Copy), Ctrl−v (Paste), Ctrl−z Undo), Ctrl− y (Redo) et
Ctrl−x (Cut) sont opérationnels, ce qui permet de gagner un temps précieux. Le résultat de l'opération
devrait ressembler à Fig8: Poignée de valise.
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L'affichage simplifié en filaire donne un aperçu peu précis. L'affichage en mode ombré, >Configure>
Shade, réserve des surprises. Ce mode est nécessaire pour vérifier que la modélisation est correcte ou
qu'elle nécessite une modification. Dans le cas présent, la poignée ressemble beaucoup trop à une
poignée de valise pour convenir à une aiguière. Voir Fig9 : Poignée de Valise Ombrée.
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Arrêtons−nous un instant sur la fonction Skin.

Il apparaît que le résultat obtenu n'est pas convenable pour la modélisation en cours. Là où des coudes
de 90° (des quarts de tore) devraient être présents, la fonction a créé des congés aplatis, tout
simplement parce qu'il manque des sections sur lesquelles tendre la surface. Il faut donc en ajouter.
Mais trois principes de base sont à prendre en considération:

−la surface (la peau) est tendue entre la première section et la dernière, non dans la position qu'elles
occupent à l'écran, mais suivant leur ordre de classement dans l'arbre de construction (première partie
de la fenêtre principale Main). Cela a déjà été dit, il importe de le répéter.

−les objets vectoriels sont orientés: ainsi, un cercle complet, ou non, balaie un angle de 0 à 360°, ou
moins, dans le sens trigonométrique et les ICurveouNcurve sont orientées de l'origine vers l'extrémité,
et non l'inverse. Ayam matérialise l'orientation par une tête de flèche (>) positionnée sur la courbe.

−la surface tendue respecte l'orientation des supports. Observez la Fig10 : Poignée de Valise Pincée
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Les trois sections du bas de l'image sont orientées vers l'intérieur ( notation arbitraire) de la poignée, et
dans le cas N°1, les sections de la partie située en haut de l'image (partie encadrée) sont également
orientées dans le même sens. On obtient une surface cohérente comme réprésentée sur la Fig 9. Dans
le cas N°2, les sections sont orientées à l'opposé, c'est à dire qu'elles ont subi une rotation de 180°.
Résultat: il y a changement d'orientation de la surface au milieu de la poignée (trois sections dans un
sens, et trois dans l'autre, donc symétrie) et l'on obtient l'objet représenté en mode ombré, qui est
assez curieux. Réstaurer cette surface est très aisé en opérant comme suit: sélectionner dans l'arbre
de construction la section mal orientée, cliquer surTransformations dans la colonne Properties de Main
et entrer la valeur 180° dans le champ Rotate Z (dans ce cas particulier). La modification est prise en
compte dès que l'on clique sur Apply. Très important: les données non validées par Apply sont
ignorées. Cela vaut pour tout ce qui sera entrepris dans la fenêtreProperties.
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Affiner la forme de la poignée.

Ceci étant considéré comme acquis, il s'agit d'affiner la poignée pour qu'elle corresponde à nos
besoins. Les explications sont à suivre sur la Fig11 : Affiner la Poignée.

Le premier travail consiste en une mise au net de l'existant, puis le second consiste en l'ajout de deux
sections inclinées à 45° sur l'horizontale.

L'arbre de construction contient l'objet spécial Root (concerne l'environnement) et l'objet Skin, qui est la
surface générée par la fonction Skin.
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Déployez l'objet Skin pour laisser apparaître les sections−supports de la surface, qui sont au
nombre de 6, et constituées de Ncurve.

• 

Renommer les sections en vue de clarification. Pour cela, sélectionner une section, cliquez sur
Attributes, entrer un nom dans le champ ObjetcName et validez par Apply. On note au
passsage qu'en cochant Hide, l'objet devient invisible mais reste présent.

• 

Sélectionner la Section5, par exemple, et la dupliquer par Edit/ Copy/ Paste. La section occupe
dans la fenêtre de visualisation la même position que son modèle, mais occupe la dernière
place dans l'arbre de construction, avec les conséquences visibles sur la forme de la surface.

• 

Hierarchiser la construction en positionnant cette nouvelle section entre la Section4 et la
Section5 par un simple glisser/déposer (drag'drop), la renommer Section45, et la faire pivoter
de l'angle adéquat

• 

Recommencer avec la Section3 pour en faire une Section35• 
Changer l'échelle successivement des Section6 et Section1, en fonction du résultat voulu, à
contrôler en mode ombré.

• 

Lorsque l'ouvrage semble correspondre aux besoins, sauvegarder le travail sous le nom de Poignee,
puis rouvrir le fichier initial par >File>Replace.
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Titre: AYAM et BMRT font la paire Article disponible en:

Auteur: André Pascual

Logiciel: AYAM3D

Insérer la poignée.

Insérer la Poignée ne présente pas de difficultés. Activez >Files> Insert. et charger le fichier
Poignee.ay. La modélisation insérée prend place sur les objets existants et l'arbre de construction
contient un nouvel objetSkin, le premier Skinétant la surface du Bec verseur. Pour éviter toute
confusion entraînant des erreurs de manipilation, effectuez une mise au propre de l'arbre de
construction en renommant les objets d'une manière explicite: Corps, Bec et Poignée. C'est une bonne
habitude à prendre, non seulement avec Ayam, mais aussi avec tout autre logiciel 3D (Hierarchy de
Moonlight, Schematics de Equinox3Detc.). Voir Fig12 : Insertion de la Poignée

La mise en place de la Poignée s'effectue en vue Side, de sorte qu'elle se situe à l'opposé du Bec
verseur. Une mise à l'échelle, une rotation et une translation seront nécessaires, au minimum.
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Peut−être sera−t'il aussi nécessaire d'effectuer des changements de vue, des grossissements, des
déplacements de contenu... et donc de recourir aux raccourcis−claviers: Ctrl−f(Front),Ctrl−s(Side),
Ctrl−t(Top), au bouton milieu de la souris (zoom) et au bouton droit (panaoramique). Si la poignée à éte
modélisée en Vue de face (Front) elle se présentera dans la Vue de face du projet en cours telle que
sur la Fig12 , mais après toutes les manipulations idoines, le projet devrait ressembler à la Fig13 : Mise
en place de la Poignée.
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Titre: AYAM et BMRT font la paire Article disponible en:

Auteur: André Pascual

Logiciel: AYAM3D

Insérer la poignée.

Insérer la Poignée ne présente pas de difficultés. Activez >Files> Insert. et charger le fichier
Poignee.ay. La modélisation insérée prend place sur les objets existants et l'arbre de construction
contient un nouvel objetSkin, le premier Skinétant la surface du Bec verseur. Pour éviter toute
confusion entraînant des erreurs de manipilation, effectuez une mise au propre de l'arbre de
construction en renommant les objets d'une manière explicite: Corps, Bec et Poignée. C'est une bonne
habitude à prendre, non seulement avec Ayam, mais aussi avec tout autre logiciel 3D (Hierarchy de
Moonlight, Schematics de Equinox3Detc.). Voir Fig12 : Insertion de la Poignée

La mise en place de la Poignée s'effectue en vue Side, de sorte qu'elle se situe à l'opposé du Bec
verseur. Une mise à l'échelle, une rotation et une translation seront nécessaires, au minimum.
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Peut−être sera−t'il aussi nécessaire d'effectuer des changements de vue, des grossissements, des
déplacements de contenu... et donc de recourir aux raccourcis−claviers: Ctrl−f(Front), Ctrl−s(Side),
Ctrl−t(Top), au bouton milieu de la souris (zoom) et au bouton droit (panaoramique). Si la poignée à éte
modélisée en Vue de face (Front) elle se présentera dans la Vue de face du projet en cours telle que
sur la Fig12 , mais après toutes les manipulations idoines, le projet devrait ressembler à la Fig13 : Mise
en place de la Poignée.
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Titre: AYAM et BMRT font la paire Article disponible en:

Auteur: André Pascual

Logiciel: AYAM3D

Poser le sol.

Plusieurs possibilités existent, mais recourrons à la facilité en faisant appel à une primitive, en
l'occurrence l'objet Box (un cube). Il se place au centre de la scène, avec des dimensions prédéfinies.
Sélectionnez Box dans l'arbre de construction, puis renommez−le Sol. Dans Properties, cliquez sur
Transformations et entrez les valeurs Scale X:10, Scale Y: 0.05 et Scale Z:10. Si ces valeurs ne
correspondent pas aux dimensions de votre aiguière, modifiez−les. Validez par Apply, puis en vue de
face (Front), positionnez−le sol sous l'aiguière. Voir Fig14: Création du Sol.
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Titre: AYAM et BMRT font la paire Article disponible en:

Auteur: André Pascual

Logiciel: AYAM3D

Ajouter un objet réfléchissant.

Ici encore, recourrons à la facilité: une sphère ou un cube eût suffit, mais en tenant de compte de qui
est déjà appris, un objet de révolution, tel un vase, sera plus approprié. Nous ne reviendrons pas sur la
façon de procéder: elle est identique à celle mise en oeuvre pour la modélisation du corps de l'aiguière.
En 1, tracez un profil; en 2, effectuez une révolution de 360°; en 3, vérifiez le résultat; en 4, mettez en
place (Position provisoire, qui pourra évoluer en fonction de l'image reflétée obtenue). N'oubliez pas de
mettre au propre l'arbre de construction en renommant l'objet. La Fig15: Ajout d'un Objet Réfléchissant
parle d'elle−même.
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Titre: AYAM et BMRT font la paire Article disponible en:

Auteur: André Pascual

Logiciel: AYAM3D

Eclairer la scène.

Tout le monde comprend que sans lumière, même virtuelle, une scène ne saurait être correctement
vue. Dans certains programmes, elle n'est pas vue du tout, ce qui n'est pas le cas de Ayam, où la
scène est soumise à un éclairage par défaut. Pour cette étape importante, la réussite d'une scène
dépendant en grande partie de sa mise en lumière, nous utiliserons trois spots plus ou moins
équidistants, selon un modèle proche de modèle dit « Hollywood ». Rappelons−en le principe: un spot
(Key Light) fournit l'énergie principale, un autre (Fill Light) attenue les ombres faciales et un troisième
(Back Light) décoche le sujet de l'ombre arrière. Dans Ayam, les données de spot qui nous intéressent
se situent dans les Properties LightAttr.: Intensity,ConeAngle (cône de spot) et ConeDAngle (zone
d'éclairement dégressif autour de la base lumineuse du spot).

Voir Fig16 : Eclairer la scène
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Titre: AYAM et BMRT font la paire Article disponible en:

Auteur: André Pascual

Logiciel: AYAM3D

Disposer un environnement.

Comme il a déjà été dit, un objet réfléchissant doit avoir autre chose à réfelchir que les tenêbres autour
de zones lumineuses, sauf si tel est l'effet recherché. Une sphère, que l'on appellera Ciel, de dimension
suffisamment importante pour contenir la totalité de la scène conviendra parfaitement. Inutile de
s'étendre sur le sujet. La Fig17: Mise en place d'un environnement parle d'elle−même; la sphère
d'environnement y est représentée en blanc. A ce stade de travail, l'arbre de construction doit
ressembler à celui de cette illustration.
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Titre: AYAM et BMRT font la paire Article disponible en:

Auteur: André Pascual

Logiciel: AYAM3D

Avant de commencer le rendu...

Avant de commencer le rendu, maintenant que nous en avons terminé avec la modélisation, il convient de découvrir l'outil utilisé, BMRT, qui se
ditPRMan compliant: compatible avec Pixar RenderMan. Cela signifie que PRMan fait office de référence, et que tout programme qui affichera la
même caractéristique de compatibilité pourra échanger des données avec les autres programmes compatibles: c'est vrai en ce qui concerne les
fichiers de scène produits( .RIB) et les shaders en mode source (.sl, shading language). Shaders, le grand mot est lâché. De quoi s'agit−il?

Il s'agit des caractéristiques qui vont affecter un objet afin de lui donner l'apparence d'un matériau précis présentant un aspect de surface particulier,
sous un éclairage défini et dans une ambiance choisie. Pour répondre à ces propiètés, cinq types de shaders existent:

−shader Surface: marbre, bois, metal, verre, velours, végétaux...

−shaderDisplacement:aspect bosselé, carrelé, balle de golf, relief divers... (ailleurs appelé bump map).

−shader Light: type d'éclairage spot, ambience, caustique, distance, fenêtre....

−shader Atmosphère: fumée, brouillard, distance focale.... qui affecte la scène et non l'objet.

−shader Intérieuret Extérieur: les même qu'atmosphère, mais qui affectent l'objet lui−même.

BMRTest livré avec une centaine de shaders, en mode source (.sl) et en mode compilé (.slc) qui pourraient suffire à satisfaire tous les besoins. Mais
il faut savoir que quantité de shaders sont disponibles en sources, afin d'être compilés aussi bien par PRMan que BMRTou 3Delight, sur des sites de
références tels que:

<http://dspace.dial.pipex.com/adrian.skilling/shaders.html> ,
<http://www.renderman.org/RMR/RMRShaders.html#BMRT>

et d'autres encore pour peu que l'on ait le réflexe Google pour effectuer une recherche sur les mots clés:shaders BMRT. Un fois les fichiers .sl
rapatriés, on les compilera en se plaçant dans le répertoire les contenant et en entrant la commande: slc nom_du__shader.sl; cela produira un fichier
nom_du_shader.slc qu'il conviendra de copier, ou déplacer dans /usr/local/BMRT2.6/shaders.

Si l'on répète souvent cette opération, on a tôt fait de se trouver en possession d'un grand nombre de
shaders dont on ne sait ce qu'il produisent après application. Comme il pourrait être très vite fastidieux
de les essayer un à un dans la scène en cours, puis d'en effectuer un rendu pour les visualiser, on
recourra à un utilitaire fort pratique, écrit en tcl/TK par Andreas Butz <butz@cs.uni−sb.de>, et appelé
TkMatMan, pour BMRT. Il en existe une version pour Air et une autre pour Aqsis, et si quelques
programmeurs sans projet pouvaient également en concocter une version pour 3Delight et
RenderDotC, la communauté entière en serait reconnaissante. Cet utiliaire permet de scruter le
répertoire shaders du logiciel concerné, et d'effectuer sur eux tous les réglages possibles afin de les
utiliser en paramètres de la scène en cours. Voir Fig18: Tests Shaders avec TkMatMan. A noter que
les résultats des réglages effectués apparaissent dans des fenêtres séparées, et non dans la fenêtre
de TkMatMancomme dans l'illustration en question, où les sphères de contrôles proviennent d'un
montage réalisé dans Gimp.
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Le confort d'usage des shaders apparaîtra immédiatement à tous ceux qui ont utilisé un autre moteur de rendu, comme celui de Moonlight, où les
matériaux prédéfinis n'existent pas, ce qui oblige à un paramètrage long et délicat pour chaque scène (à moins de ruser pour récupérer des
matériaux précédemment créés). Ainsi, trois sphères sur un sol plan ont vite fait de ressembler à des fruits sur un plancher, des billes de verre sur un
damier, des boules de bois ou des billes chromées de roulement sur une tapisserie etc,. Cela en quelques clics de souris. Voir Fig19: Application des
Shaders.
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Titre: AYAM et BMRT font la paire Article disponible en:

Auteur: André Pascual

Logiciel: AYAM3D

Appliquer des matériaux dans la scène en cours.

Beaucoup de choses seraient à dire à propos des shaders: des ouvrages techniques leur ont été
consacrés. Mais ce qui nous intéresse au premier chef, c'est de les utiliser pour donner du réalisme à
la scène modélisée précédemment. Ici non plus, nous n'entrerons pas dans des détails trop pointus.
Que l'on sache simplement quelle est la démarche à suivre dans Ayam.

En dix étapes, le synospsis de création et d'affection d'un matériau à un objet correspond à ceci:

−1 Cliquer sur l'icône Create Material.

−2 Donner un nom à ce matériau dans la boîte de dialogue qui vient de s'ouvrir.

−3 Le nom défini apparaît dans l'arbre de construction; sélectionner ce matériau.

−4 Cliquer sur Surface dans Properties.

−5 Cliquer sur Set new shader.

−6 Sélectionner le shader voulu dans la liste déroulante surgissante et valider par OK. Si aucun nom
n'apparaît dans la liste, c'est queBMRT n'est pas correctement installé, et, notamment, que la variable
d'environnement SHADERSn'a pas été définie dans ~/.bashrc.

−7 Modifier les paramètres du shader dans Properties, si nécessaire.

−8 Selectionner l'objet auquel affecter le matériau, et par drag'n'drop déposer celui−ci sur le nom du
matériau dans l'arbre de construction.

−9 Vérifier que le matériau est bien affecté à l'objet en cliquant sur Materialdes Properties de l'objet.

−10 Le nom du matériau doit correspondre à celui que vous avez affecté.
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La Fig20 : Synospis de Création d'un matériau, résume tout ce qui vient d'être enoncé.
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